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Installing PDFBlaster

% PDFBlaster Setup |

Welcome to PDFBlaster Setup
Wizard

The Setup ‘Wizard will install PDFElaster on wour computer,
Click Mext bo continue or Cancel ko exit the Setup Wizard,

PDFBLASTER

intelligent
document delivery
from accounting

data_fabrication

Zancel |

Make sure you have already downloaded the latest version of PDFBlaster
(http://imww.pdfblaster.com/download) and your activation code available.

Double-click the pdfblaster.exe program to start the install.

You will be presented with the screen show above. Click Next to continue.
When asked, Click the "I accept the terms in the License Agreement" option.
Then, Click Next to continue.

Then, Choose the folder location where you want PDFBlaster to be installed. The default, which
is suggested for most users, is C:\Program Files\DataFab\PDFBlaster.

Click Next again to continue.

Finally, Click the Install button to begin the installation.
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Completing the PDFBlaster Setup Wizard

% PDFBlaster Setup |

Completing the PDFBlaster
Setup Wizard

Click the Finish butbon ko exit the Setup Wizard,

¥ Launch POFElaster

PDFBLASTER

intelligent
document delivery
from accounting

data_fabrication

< Back I Einish I Zance| |

Once the PDFBlaster setup wizard has completed you may be prompted to reboot your computer
in some cases. If this happens be sure to reboot your computer immediately to ensure that the

PDFBIlaster installation completes successfully.

If you don't need to reboot, you'll have the option to launch PDFBIlaster by checking the

appropriate check box.

Click Finish to complete the installation.
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Starting PDFBlaster For the First Time
(] PDFBlaster |_ O]

File Edit Custom  Help

Cutho: I Seﬂingsl Cuztom Queriesl Send Log I Archiving I

Unzent Jobs:
Job (D | o rer | Statuz | Type | To COompany | To Mame
PDFBlaster |
9P ) POFBlaster can autamatically check For Free updates ko this program.

-
Would vou like to check For a new version now?

Sk

Delete

=

Befrash Outbox

=0

Send

| | y

Before starting PDFBlaster for the first time, make sure you have your Quickbooks software
running and visible on your computer.

The PDFBIlaster Control Panel can be started from your Windows Start menu. Look for Start ->
Program Files -> PDFBlaster -> PDFBlaster Control Panel and click on this link when you find it.

When PDFBIlaster starts up for the first time, it will ask you if you want to check for updates to this
program. Click "No" for now.

NOTE: In the future, It's a good idea to click "Yes" to check for any updates. This way you can be
sure you have the latest version of the PDFBlaster software. If you select "No", PDFBlaster will
remind you every 30 days to check for updates.
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Select Your Accounting System

® PDFElaster Setup Wizard |

Please select the accounting system you want to link to. The
selected accounting system must match the accounting
sy=temn assigned to your activation code

(Wl o F-uickBooks ProPremier

PDFBLASTER

Cancel | Help = Back | Mext = Eimizk

If this is the first time you are running the PDFBlaster Control Panel, you will asked to complete a
quick 5 step setup wizard that will help you link PDFBlaster to your accounting system, configure
your email server settings (for sending PDF emails) and activate your software.

The first step is to select your accounting system from the drop-down list.

Choose QuickBooks Pro/Premier

Click the Next button
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Linking To Yo

ur QuickBooks Database

# PDFBlaster Setup Wizard

PDFBLASTER

]|

connect to your accounting system.

Please enter the following information so PDFBlaster can

System Directory; |©Program FilesintuitluickBooks Pr

Cancel |

Help = Back Mext =

Eimizk

Select the root directory (folder) where your QuickBooks software is installed. This is typically on
a local hard drive. If you have QuickBooks installed on your local computer as a stand-alone
system the default folder is C:\Program Files\Intuit\QuickBooks Pro.

Cick the browse button [...] and select your QuickBooks data file. These files typically end with a
.gbw file extension. Make sure you have your QuickBooks software running and visible before

completing this step.

Click the Next button to continue.
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Allowing PDFBlaster To Access QuickBooks Data

QuickBooks - Application Certificate

&n application is requesting access to the Following QuickBooks
comparry file:

Rock Castle Construction

— &pplication Mame and Developer
rame: PDFElaster

Developer:  Daka Fabrication Inc

— Certificate Information
Developer identity has been verified by:
Thawte Code Signing 4

— CQuickBooks Solutions Marketplace

Search For information about this application at the
+ QuickBooks Solutions Marketplace

f,ﬁ.llcuw this application to access Social Security Mumbers and !
other personal data.

What does this mean?

Do wou wankt to allow access?

Yes, This Time Yes, Always Mo Help

The first time PDFBlaster connects to your QuickBooks data file tab over to your QuickBooks
window. You will notice a form being displayed like the one above. Click Yes, Always to always
allow PDFBlaster to access your QuickBooks data without prompting you.
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Allowing PDFBlaster To Access QuickBooks Data

¥ rRock Castle Construction - QuickBooks Pro Edition 2003
File | Edit %iew Lists Compamy Customers ‘endors Employees Banking Reports window  Help

— o £ =
Eur e[ A @ o B & Q4 o 9
Tnwai  Revert Check Bill Feq  Accnt Rmnd  Find  Backup  Support
Cub ZhrlH-
Hav oy Chrl4-C
Paste b,

Lse Peqister Chrl+R Related Activities

"":/ @ ﬁ @ Send Forms. .
/

Use Calculator

BB B Fih

simple Find...  Ctrl+F Invoices : : : T E B} PrintInvoices..
Advanced Find. .. :
Preferences. .. [ S 7 'y 8 &dd & Customer...
& 4 &
Help & Support Finance  Statements  Refunds ﬁ Customer Center...
2 T Chatrges and Credits
. (== Cusztomer Detail Center...
Open Windows 08
Customer M avigator RSaaIg:aJc | W o
: 7 eceipts Papments...
Automatic Update - Priv... P
Getting Started ?.J;;,; @ E/ _‘b Memorized Reports _
Customers [tems & Templates Custumer Credit
Services Register Letters Check ICustDmerS I

|?ustumer Solutions | oo _I _|;I
1 3

Next, in QuickBooks click Edit -> Preferences to access your preferences screen.
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Allowing PDFBlaster To Access QuickBooks Data

Accounking

&

Checking

!'l'l“'[?.

Desklop
Wiew

%y

Finance
Charge

T

General

ada

s
-

Integrated
Applications

My Preferences

l Company Preferences I

2 5|

[ Don't allow any applications to access this company Filsd

You can manage all applications that inkeract wikh this QuickBooks company file
here,

[ MotiFy the user before running any application whose certificate has expired

Applications that have previously requested access ko this companty file

Allow Access

Application MNanme

v POFElaster

la

A

o QuickBooks Solutions Marketplace

Propetties. ., |
Remoyve |

To learn more about applications that integrate with GuickEooks, go to the

Cancel

Help

Defaulk

Pk

Also See:
General

Service
Conneckion

Scroll down on the left to Integrated Applications and click it. Then click the Company
Preferences tab. Highlight the Application line that reads PDFBlaster and make sure that the
Allow Access option is checked.

Next click the Properties button.
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Allowing PDFBlaster To Access QuickBooks Data

Properties - PDFBlaster Ask a help question |Askl % How Do I? |

J Access Rights I Details I

[V allow this application o access this company file

[T Prompt before allowing access

W ‘allow this application to login automatically

Login as:
I.ﬁ.dmin ﬂ

u Allaw this application to access Social Security Murmbers and
other personal data

What does this mean?

oK Zancel Help

Search For information about khis application at the
- QuickBooks Solutions Marketplace

In the Access Rights tab, check the Allow this application to access this company file check box,
and then check the Allow this application to login automatically. Finally, choose the appropriate

Login entry from the Login As: drop-down.

When finished, click OK.
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Testing Your Accounting Database Link

» PDFBlaster Setup Wizard |

You are now ready to test your accounting link. Click the
[Test Link] button to test your settings.

PDFElaster |:|

-
1 J Connection Succeeded

PDFBLASTER

Cancel | Help = Back Mext = Eimizh

Now, tab back to your PDFBlaster window to continue.

Click the Test Link button to test the link between PDFBlaster and your accounting system.

If the information you entered is correct you will see a "Connection Succeeded" result message
like the one shown above

If the test link fails, most likely you have entered in incorrect accounting database information.
Please contact your network administrator to obtain the correct settings.

Click the OK button to dismiss the Connection Succeeded dialog.

Click the Next button to continue
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Entering Your Personal Contact Information

® PDFElaster Setup Wizard |

Please enter your personal contact information. This
information will be used when sending PDF email
attachments or on your fax cover sheet.

From Company: IAEIC Distribition and Service Corp.

Fram Mame: I-.h:ue Andrews

Frorm Email: Iiandrews@abcdis’crihuﬁng.u:u:um

PDFBLASTER

Eimizk

Cancel | Help = Back | :

If your link to your accounting system was successful, your From Company name should be pre-
filled. You can override this value by typing in your Company name as you wish it be viewed
when sending faxes and emails through PDFBlaster.

Enter your From Name, which is typically your personal name. However, you may want to use a
more generic from name such as "ABC Sales" if you want to not have your own name appear in
faxes and PDF Emails.

Enter your from email address, which is typically your own company email address. Again, if you

elect to use a more generic from name, you can change this from email setting to match an email
alias that has been set up on your mail server, such as sales@abcdistributing.com.
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Configuring PDFBlaster To Work With Your SMTP Server

® PDFElaster Setup Wizard |

Please enter your outgoing SMTP mail server settings. If this
i5 an evaluation copy you can skip this step for now but you
will need to configure your SMTP =settings once your
software has been purchased.

Cutgoing Mail Server: Imail.abcdistrihming.-:um

Outgoing Mail Server Port: |25

[T User Authertication Reguired

Test SMTP Settings

PDFBLASTER

Eimizk

Cancel | Help = Back | :

If you plan on sending PDF emails through PDFBIlaster, you'll need to enter your outgoing mail
server information in this step. If you use Microsoft Outlook as your email client you can look at
the email account settings in Outlook to get the information needed here. Otherwise, if you don't
know what your outgoing SMTP server settings are you will need to contact.

If your mail server requires authentication, check the appropriate box and enter your mail server
login and password. You'll also need to know the "Authentication method", but in most cases,
this is simply NONE. Some high-security mail servers use other methods but if you're not exactly
sure what to use, try the NONE setting.

NOTE: Important note about your entered email address and your outgoing SMTP server:

Many outgoing mail servers are increasingly being "locked down" to prevent usage by
unauthorized email spammers. If you have trouble connecting to your outgoing mail server from
PDFBlaster, make sure that the email address you entered is already set up in your mail server
configuration. For example, you may have entered sales@abcdistributing.com as you from email
address, but there is no sales@abcdistributing.com email alias set up on your mail server. If this
is the case, either have your mail administrator add this email address, or else use your personal
company email address as your from email address in PDFBlaster.
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Testing Your SMTP Mail Server Settings

» PDFBlaster Setup Wizard |

Please enter your outgoing SMTP mail server settings. If this
i5 an evaluation copy you can skip this step for now but you
will need to configure your SMTP =settings once your
software has been purchased.

PDFElaster |.
Outgoing M

L3
Outgoing - 1 ) SMTP Settings Test Was Successhul!

PDFBLASTER

| Test SMTP Settings |

Cancel | Help = Back | Mext = | Eimizh

|Testing SMTP Settings...

After you enter your outgoing SMTP server settings, click the Test SMTP Settings button to test
your configuration. If you settings are correct you will see a response dialog like to one shown
above.

If your SMTP test fails it is most likely because one or more of your outgoing SMTP mail server
settings was incorrect or that your authentication failed when PDFBlaster tried to contact your
mail server. Please check with your ISP or network administrator to obtain the correct outgoing
SMTP mail server settings.

If you test was successful, click Next to continue.
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Entering Your PDFBIlaster Activation Code

® PDFElaster Setup Wizard |

Please enter your assigned =software activation code. You
must be able to connect to the Internet to proceed past this
step.

Activation Code:  [999933-393553533

PDFBLASTER

Eimizk

Cancel | Help = Back | :

Please enter the activation code provided to you via email or from your PDFBlaster reseller.
Make sure you enter the number exactly as it is provided, including the dash.

Click Next to continue.

After entering your activation code you will see a screen indicating that your activation code has
been accepted by the system.

Then, Click the Finish button to exit the wizard.

NOTE: Important Note about failed activation attempts:
If you software activation attempt fails, it is most likely due to one of the following scenarios:

You entered an incorrect activation code

You entered a valid activation code but are linking to an accounting system that is different than
the one you signed up for

You exceeded the allowable license count limit for your account.

If you are using PDFBIlaster in trial mode, you can only install PDFBlaster on a single workstation.

If you have already purchased PDFBlaster, then you may have run out of available license
activations, in which case you will need to purchase more license activations.

www.pdfblaster.com | support@pdfblaster.com




PDFBlaster QuickStart Guide: For QuickBooks Page 16 of 25

Printing To PDFBlaster From QuickBooks

™ Rock Castle Construction - QuickBooks Pro Edition 2003

File Edit “iew Lists Company Customers Vendors Employees Banking Beports  Window  Help

- - -
Mew Compans, .. __d @ 5 |a:| @ Q J j)
Open Company... Theck Eil Feg Accnt Rmnd  Find  Backup  Suppork
Open Previous Company 4
Easyatep Inkerview
Close Company __‘,..a \ {
= i =
Switch bo Mulki-user Mode o Q @ Send Foms...
_ili'u-:"‘o.i_ces Receive g Deposits =
Back Up. .. . . Payments % Frint Invoices...
Restare. .. =, N - 8 dd & Cust
' | 7 ' p a Customer..
Archive & Condense Data, ., ) 2; - o 3}?/]
Litilties " i N & Customer Center.
) Finance  Statements  Refunds == lle el
Timer 4 Charges and Credits
Accountant's Review 3 0% Customer Detail C
Prink R oy Process Credit Ce
Print Eotms Bill Pavment Stubs. .. Payments.
Printer Setup. .. Checks. .. o N
- = Vi Memonzed Repi
E-mail Farms » Credk Memos... : _é p
Shipping ’ .. br | wrte  Credit
- Lett Check.
. . " Mailing Lahels. ., Ellers e I Customers
Reqgisker QuickBooks Pra Edition Paychecks
Update QuickBooks. .. | Paystubs. .. &R Ading Sur
Exit Alt+F4 - Cuztomer Bala
- Purchase grders. At i Detal
@t? Sales Receipts. .. e Mo additiohal software Cuztomner Bala
Timesheets, .. Mare. Sumrmnary =
Qe Inevoice
o 1099s.., | j—l

Once your PDFBlaster Control Panel is linked to your accounting system and configured
correctly, all you need to do is print your accounting documents (invoices, statements, purchase
orders, etc.) from your accounting system and select the PDFBlaster printer as the selected
printer.

For example, suppose you want to send out your invoices from QuickBooks. Open the File ->
Print Forms menu and select Invoices as shown above.

www.pdfblaster.com | support@pdfblaster.com
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Printing To PDFBlaster From QuickBooks

Select Invoices to Print

|

AJE Account j
Select Invioices ko print, then click Ok, DK
There is 1 Invaice o prink Ffor 4, 360,50, cancel

4 Date Twpe M, Cuskarner Template Arnounk

S 1211502005 [INY |92 Ecker Designs:JRock Castle 4,360,50 | Help

Select all
Select None
Print Mailing Labels

On the next screen confirm the invoices that you want to print by checking/unchecking the
invoices from the invoices list.
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Printing To PDFBlaster From QuickBooks

Jiel:tingsl Fonts I

Print
== 1l [P DEElaster on Mel2: opkions, ..
Cancel
Printer type: Page-otiented (Single sheeks) j |
Help
Mote: To install additional prinkers or to change port:
assignmenks, use the Windows Conkral Panel, Ereview
. _ . . Align
Printorm: € Intuit Preprinted forms. Moke: The Farm Template provides

additional print settings such as Logo
' Blank paper, selection, Templates are accessed by
" Letterhead. selecting Templates from the List
MEnL.
™ Do not print lines around each Field.

rumber of copies: |1_

Make sure you select PDFBIlaster as your output printer. If it's not your default printer click the
Printer Name drop-down and select PDFBlaster as the printer.

Click Print to continue.

Your accounting system will then start printing your invoices to the PDFBIlaster printer
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Printing To PDFBlaster

[ PDFBlaster

IM[=] E3
File Edit Custom Help
b I Seﬂingsl Custom Queriesl Send Log I Archiving I
Unsent Jobs:
Job D Crvner Status Type To Company To Mame
m administrator Mot Sert Invoice

Jenny Morgernthaler
Ecker Designs
Ernesto M Matiello

o000z adminiztrator Mot Sent Invaice
oooog administrator Mot Sent Invaice

1 |

data_fabrication =

dissign.code.appication.® Delete

=

Befrash Outbox

Jenny Margent
Deanna Ecker
Ernesto Matiello

| PDFBlaster Control Panel |

4

As your invoice jobs are received by the PDFBIaster Control Panel, PDFBlaster will automatically

pre-address each invoice in your outbox for you.

Highlight the first job and then click the Send button.
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Printing To PDFBlaster

¥ smartFind™ Results: |
COmpany; IOrange Door & Window: Co.
Recipient Mame: IHaru:uId Englizh, Presidernt
Recipient Email: Ihenglish@nrange.mm
Recipient Fax: |31 25551212
Subject: ISaIes Order From Joe Andrewws at ABC Distribution and Service Cor

CC Email ]

=
Bocly: To viewy the attached Sales Order, you need the free Adabe ﬂ
Acrobat Reader, which is available from wenwy adobe com.

Archive Comments: ;I

Zend Rule:
data_fabrication eV 5 | DX§
design.oode.sppication.® Atachments Send Cancel

|F‘Iease confirm the fallowing SmatFind™ results |

Since your send option was set to "send each print job individually" and "confirm each job" you
will be presented with the SmartFind Results confirmation screen shown above. At this point you
can select the defaulted recipient and send rule settings, or overwrite them with your own, change
the send rule for this job from the drop-down or edit the body of the message (which will appear in
the email or on the fax cover sheet).

Since your global send rule was set to "send as a test to my email address" this is the default
send rule for this job.

Since you want to send this invoice via fax, click the Send Rule dropdown and change the rule to
"Always send as fax".

Now all you have to do is click the Send button to deliver your fax.

After your print job is sent, and entry is added to the Send Log tab, which you can view, print to
clear at any time.

That's it!
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Support and Purchasing

To Obtain Additional Technical Support

Visit our online support site at www.pdfblaster.com/support
Email us at support@pdfblaster.com

To Purchase PDFBIlaster

Contact our sales hotline at 312.264.2378
Email us at sales@pdfblaster.com
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Extra Information

The following pages will give you some extra information about the PDFBlaster interface and
some advanced options you have.

These items are all optional, and you don't need to configure any of these things to start sending
your first trial faxes and emails.
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The PDFBIlaster Control Panel

{5 PDFBlaster [_ O]
File Edit Custom Help
b I Seﬂingsl Custom Queriesl Send Log I Archiving I
Unzent Jobs:
Job (D | et | Statuz | Type | To COmpany | To Mame

1 |

2+

B

data_fabrication

desgn.Cooe.B0DECEToN. Y

|Right--:|iu:k prink job Far

"~
more u:uptiu:unsl

Delata Befresh Duthox |

Send

| PDFBlaster Control Panel |

4

PDFBlaster uses an "outbox metaphor" to receive print jobs from the PDFBlaster printer. These
jobs will show up in your outbox screen, shown above and identified by the outbox tab at the top.
Depending on your Send Rule settings, print jobs will either queue up in your outbox until you
send them yourself or they will automatically be delivered as they are received. Please see the

next section for more information.
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The PDFBlaster Settings Tab

{5 PDFBlaster [_ O]

File Edit Custom Help

Cuthox  Settingz | Custom Queriesl Send Log I Archiving I
—Global Send Rule: ———————  — Accounting Link Settings:

ISend &= test to my email j Link Tax: IEIEST MA=30/200 j

—POF Archiving

[~ &rchive My Print Jobs Login Settings | Test Link |

— My EmailFax Settings:

From Company: IAEIC Diztribwtion and Service Corp.

From Mame: I.Ju:ue Andresns

From Email: Iine@ahcdistrihuting.cnm

Cover Page: IC:WPngram File=\DataF ahPOFBlasterpdfh_cover rif _I

Omit cover page on faxes: [

—Send Settings:
" Send print jobs automatically " Send without confirming each recipient
¥ Send each print job individuslly e Confirm each recipient before zending
” Send print job= at a specific time each day Im j:lm j I'E‘M j
| PDFBlaster Control Panel | y

The PDFBIlaster Settings tab contains settings that control how you want to process print jobs in
your outbox.

The Global Send rule defines your top-most preference for sending out print jobs, and these can
be a combination of fax, email and hard-copy printing. Depending on the recipient data of a
particular job, different send methods may be used. For example, suppose you have an invoice
that will be sent to Acme Corporation and your global send rule is defined as "fax first otherwise
email". The company data for Acme in your accounting system contains an email address but no
fax number. When this job is sent through PDFBIlaster, it will choose email as the method of
delivery because there is no fax number present. Had there been a fax number, then the delivery
method would have been internet fax.

The Send Settings section contains options that control how and when your print jobs are sent. If
you select "send automatically” then print jobs are sent as they are received in the outbox. You
can send jobs individually by highlight the job in the outbox and clicking the Send button. Lastly,
you can configure PDFBIlaster to send all print jobs in the outbox at a specific time each day.

For details on the other options contained on the Settings tab please visit our online help center
at www.pdfblaster.com/support.
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PDFBlaster User Preferences

# PDFBlaster User Preferences |

—User Preferences
[w Show Control Panel it outhox iz not empty: [T & me on all zent print jobs

[ | Enakle ELFElsster Toolbar for Microsaft YWard [~ Error Logging
[+ Preview PDFz when confirming each job [T Akways Start Minimized
[T Clear default stachments after sending [T Disahble Reseller Branding

[¥ Cwverride Outlook security, and allow sccess to Qutlook emsl sddresses

[T Dizakle cover page selection or editing for all users onthis computer

[T Allow atternste recipients for accourting document print joks

[ Fax all print jobs to & specific fax number

—Hard Copy Printing Preferences

Prirt all jobs to hard copy printer after processing regardless of send rule m
Print only accourting document jobs for which there iz no email and fax number ]
Azk befare printing each jokb r

Global Aftachments Save And Exit Cancel

You can access the User Preferences screen by selecting Edit -> Preferences from the
PDFBlaster main menu. Most of these options are self-explanatory but the most common
preferences are:

Show Control Panel if outbox is not empty — selecting this option will cause the PDFBlaster
control panel to pop up as the topmost window reminding you that there are unsent print jobs.
Preview PDFs when confirming each job — selecting this option will display a PDF preview using
Adobe Acrobat (which must be installed on your computer) when you attempt to send each job.
This setting has no effect for auto-send or send at a specific time send modes.

CC me on all print jobs — selecting this option will cause PDFBlaster to send a CC PDF email with
attachment of every job you send, regardless of whether the job is a fax, email or print job. CC's
are sent to the PDFBlaster From Email address.

Always start minimized — selecting this option will cause PDFBlaster to start in your system tray
and out of the way until you double-click on it. Print jobs are still queued and/or processed if
PDFBlaster is running in minimized mode.

Hard copy printing preferences. If you have a hard-copy printer defined as your default printer,
you can configure PDFBIlaster to print every print job regardless of the send rule. This option
requires the Adobe Acrobat Reader to be installed on your computer.

Global Attachments — when selecting this option, the files you select as global attachments are
appended to every print job you send, regardless of whether it is a fax, email or print job.
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